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, l ‘ We know
s | D ¢ D0KE

In urma parcurgerii acestui capitol, vei invata cum sa utilizezi aplicatiile de calcul tabelar. Cu acestea te
vei intilni destul de des, atdt pe telefon sau tableta, dar si pe calculator atunci cdnd vei dori sé creezi si sd
gestionezi aplicatii care utilizeaza tabele.

Iti vom prezenta in continuare cateva detalii si mici trucuri necesare in executarea unor calcule, si nu
putine, in utilizarea formulelor de calcul, in construirea diagramelor, in manevrarea tabelelor.

Nu va fi greu, este nevoie doar de atentia ta si lucrurile vor merge foarte usor.

Mult succes 1n noul an scolar!

Calculul tabelar, in general, este un program care pune la dispozitia utilizatorului un mare numir de
instrumente care pot fi manevrate cu usurinta. Este util si realizarii de diagrame, dar si realizarii bazelor de
date sau analizei de date.

Excel (pronuntat [1k'sel]), ca aplicatie a pachetului Microsoft Office, este un program !
destinat, in principal, exact calculului tabelar. Documentele editate cu aceastd aplicatie sunt usor n
de recunoscut dupé pictograma alaturata. '

Numele documentului salvat, folosind Microsoft Excel, este urmat de extensia.x1lsx.

*

** Numele intreg este Microsoft Excel.
<» Formatul a fost . x1s, de la prima versiune pana la Exce/ 2003, devenind de la Excel 2007 .x1sx
(folosita in standardul international Office Open XML pentru documentele Office).

*¢+ A aparut in 1982, initial sub denumirea de Multiplan, aplicatie dezvoltata de Microsoft.

Pentru a deschide aplicatia Microsoft Excel, in functie de versiunea sistemului de operare instalat, urmam
pasii Start > Microsoft Office 2> Microsoft Excel sautastim, in caseta de cautare a sistemului
de operare, Microsoft Excel. De cele mai multe ori, dupd instalarea pachetului Office, pe desktop exista
pictograma programului Microsofi Excel.

La deschiderea aplicatiei
Excel apare fereastra alaturata.
Multe elemente 1iti sunt deja
cunoscute din aplicatiile ———°
studiate in clasele anterioare: | casera barade barade ~ barads
bara de titlu, bara de meniuri, = *™™ e R bk oalodue RS
bara de acces rapid, panglica cu S
butoane. Specifice aplicatiei

sunt: caseta de nume, bara de |

bara da titlu

maneyrarea terastres
etichetade rand
zona de lucru

eticherafon

formule, zona cu denumirile de caloul
(etichetele) foilor de calcul.




Imediat sub bararde titlu se afla bara de meniuri principale. Fiecare dintre acestea desfisoard meniuri pe
orizontala = Panglica de butoane (Ribbon).

Bara de instrumente de acces rapid (Quick Access
Toolbar) poate fi modificatd conform preferintelor

utilizatorului.
% Ckn vitt v K & | ==E 8- Elhodeetet Gemenil - ¥ A, tm =X | E E_"' p
2 = 3z > = 3 = m. -
Lipre ‘ BIg-E-B-A- == EE = imbinore i centrare. - XL L BT Formatuse:  Formatare Stiluside | incesare Slergere Format | Sortare i Gdsire s
. condionati- catabel - celole~ v - 7 fitrare - selecture -
Oghcard 5 Font 5 Alisere i1 Humdr = haur Cebule Esdare

$ﬁﬂ_i_§§ :-3 e

% Pentru fiecare optiune a meniului se poate folosi combinatia de taste scrisd in dreptul meniulul.

< Putem folosi doar tastatura ca sd navigdam prin fiecare fild a meniului (ALT + litera corespunzatoare).

l

Structura unui registru de calcul

Foaie de calcul

In programul de calcul tabelar, elementul principal este foaia de calcul, numitd worksheet sau, mai
simplu, foaie (sheet). Putem privi foaia de calcul ca pe o foaie de hértie pe care se deseneaza, pentru inceput,
un tabel. Un fisier Excel contine una sau mai multe foi de calcul grupate intr-un registru de calcul (workbook).

La deschiderea unui registru de calcul, implicit apare un anumit numar de foi de calcul, dar se pot
introduce alte foi atunci cand este nevoie. Foaia de calcul activa. cea in care se lucreaza la un moment dat, are
eticheta evidentiata cu o culoare.

Daci este necesar, se poate face copiere sau mutare de foi de calcul in cadrul aceluiasi registru de calcul
sau chiar intre registre de calcul diferite (cu conditia ca acestea si fie deschise). Se executd click dreapta pe
eticheta foii de calcul ce se doreste copiata sau mutatd si se alege optiunca Mutare sau copiere (Move

or Copy).
3 Butave sau copiers ? x
Se muth fode selsctate Se alege, din meniul derulant,
e e fisierul in care se doreste

copierea sau mutarea foii de
caleul.

Se selecteazd, dacd se
doreste, o copie a [oii de

calcul Se apasd pentru

finalizarea actiunii.




O alta modalitate pentru copierea 1n acelasi registru al unei foi de calcul: se executa click pe eticheta
acestela, se tine apdsat butonul sting al mouse-ului, se apasa tasta Ctrl si se trage eticheta la locul dorit; se

elibereaza butonul mouse-ului si apoi tasta Ctrl:

Rigv CEtEp L) colegi (2) ey cslenp iy

Foaia de calcul nou-creata va avea denumirea foii sursa si un numir ce indici duplicarea ei. Atentie!

Duplicarea foii de calcul nu se poate anula folosind butonul Undo (Ctrl+2z, ).

Coloanad, rind, celuld, adresad de celuld

Zona de lucru este sub forma unui tabel impartit pe randuri si coloane. Unitatea elementara, aflata la
intersectia unui rind cu o coloand, in care se scrie un text sau o formuld, se numeste celuli. Aceasta se identifica
prin numele coloanei si al rAndului la intersectia cérora se afld. Astfel, coloanele se numeroteazi cu litere, A,
B, C..., Z, AA, AB, ., iar randurile, cu numere naturale, 1, 2.... Asadar, celula identificatd prin A3 se afli la
intersectia coloanei A cu randul 3.

In aplicatiile de calcul tabelar, asa cum am vazut deja, datele sunt organizate pe randuri (identificate
prin numere: 1, 2, 3,...) si coloane (identificate prin litere: A, B, C,...).

coloanid 83 celula
activa
A g C
rand > celula

Identificarea unei celule se face prin folosirea unei adrese sau referinte formate din litera coloanei si
numarul rdndului in care se afld celula respectiva. Celula activd (curentd) este indicatd printr-un chenar
ingrosat si are afisatd referinta in caseta de nume (in figurd, se poate observa ci celula activa este B3).

Operatii cu un registru de calcul

Deschidere, inchidere, salvare, creare

La crearea primului figier, inainte de salvarea lui, denumirea este
datd automat de cétre Excel: Registrul (workbookl). Acesta se poate
redenumi, prin operatia deja cunoscuti de salvare, Fisier (File) =
Salvare ca (Save As). Alte modalititi;: Ctrl+S, Alt+F2,

Shift+F12, butonul Salvare (Save) A . Daci se doreste salvarea
intr-un folder nou, se foloseste butonul Folder Nou (New Folder).

Tn anumite situatii, cand fisierul contine date confidentiale, se poate instumente = | Sabare
aplica o parold, ca misura suplimentarda de securitate: butonul Conectare unate de retes.
Instrumente din fereasta de dialog Salvare ca. z:;m 9:;*

Atentie, nsd, parola nu trebuie uitatd de utilizator! T ———

Un registru are, la inceput, un anumit numir de foi de calcul,
etichetate Foaiel (Sheetl), ..., in functie de versiunea Excel instalati. Foaiel 0
In versiunea 2019, registrul contine la deschidere o singura foaie de calcul.

-




Dupi terminarea Tucrului intr-un fisier Excel, pentru inchiderea registrului de calcul curent si pentru
parisirea programului, se folosgste Fisier - Inchidere. Asa cum stii deja de la celelalte aplicatii

Microsoft invitate anterior, putem folosi butonul din coltul dreapta sus al ferestrei BN
Sub bara de butoane sau instrumente, se gaseste, in
partea stAngd, caseta de nume. Aici, este afisatd ultima =

celuld selectatd sau coltul din stinga sus al unui domeniu A 8 C
de celule (adic# a unei zone din foaia de calcul formata din
mai multe celule care, la un moment dat, suporti o aceeasi : | I—

prelucrare) daci se selecteaza un domeniu. Imediat 1anga,
in bara de formule, apare continutul celulei active.

Aceastd bard se modificad in functie de calculele
care se fac in tabel prin intermediul formulelor. Si caseta
de nume se modifici in aceastd situatie, in locul ei = s
apirind o listd derulanti cu functiile predefinite; :
continutul celulei va arita formula utilizata.

(el

Operatii cu foi de calcul

Accesare, redenumire

Foile de calcul pot fi accesate cu un click direct pe eticheta (numele) lor.

Foawel Foael Foaiel +

Intr-o singura foaie de calcul pot fi scrise foarte multe date, totusi se recomanda utilizarea mai multor
foi de calcul. Indiferent de numarul acestora, registrul de calcul este considerat a fi un singur figier.
pentru redenumirea acesteia.
o dublu click pe numele ei;
o click dreapta pe numele ei, apoi Redenumire (Rename);
o Fila Pornire - Format - Redenumire Foaie (Rename Sheet).
Numele vechi va fi evidentiat si inlocuit imediat ce se tasteazi cel nou.
Se pot adiuga foi de calcul in plus fatd de cele existente la inceput prin apsarea butonului Foaie

| &

nouid .~ sau Shift+F11. Noile foi se adaugi in ordinea inserarii, adici, daca se adaugd Foaie5 si apoi
se sterge, urmitoarea foaie noud adiugati va fi Foaie6. Fiecare foaie noud se insereaza la dreapta celei active.
Eliminarea unei foi de calcul se realizeazi prin click dreapta pe numele ei, apoi Stergere (Delete).

Atentie! Stergerea este definitiva, deoarece butonul Undo (Ctrl+Z, i.._;) nu are niciun efect In acest caz.
Ascunderea unei foi de calcul se realizeazi prin click dreapta pe numele ei, apoi Ascundere (Hide).

Atentie! O foaie ascunsi nu mai este vizibila in registrul de calcul. Reafisarea ei se face prin acelasi procedeu,

si anume click dreapta pe numele unei foi, apoi Reafigare (Unhide). Atentie! Butonul Undo

(Ctrl+Z, & ) nu are niciun efect in acest caz.

Daca este necesar, foile se pot reordona astfel incat fiecare foaie si se afle in pozitia doritd in cadrul
aceluiasi registru de calcul. Se executi click pe eticheta ei, apoi se trage in noua pozitie.

O foaie de calcul poate fi evidentiati cu o culoare; astfel, atunci cind nu este activd, aceasta este
remarcati mai usor. Procedeul este similar oricarei operatii aduse unei foi de calcul: click dreapta, apoi

Culoare selector (Tab Color) ,_ﬂ!__‘




Recapitulare operatii registru de calcul

Creare registru nou e Fisier (File) > Nou (New) —> alegem un tip de sablon >
Creare (Create)
e Folosind doar tastatura; Ctrl+N (New)

Deschidere registru existent e Fisier (File)- Deschidere (Open)
e Folosind doar tastatura: CTRL+0O (Open), apoi selectdm registrul
dorit.

Deschiderea si vizualizarea Se repetd pasii precedenti pentru fiecare registru.
mai multor registre de calcul Vizualizare (View)> Fereastrd (Window) 2>

L Vizualizare alaturate

Salvare registru ¢ Fisier (File)-> Salvare
e Folosind doar tastatura: CTRL+S (Save)
Daci fisierul nu are deja un nume, adici este la prima salvare, se poate
alege Fisier (File) - Salvare ca (Save As) siise dd un nume.

Salvare registru sub un alt Fisier (File) > Salvare ca (Save As)
nume, un alt format sau 0 altd ~ Se redenumeste registrul, apoi (la alegere) Save as type, se selecteazi

locatie formatul (.zxt, .xls, pdf, html, xlf).
Creare copie registru curent

Inchidere registru e Fisier 2 Inchidere (Close)

Inchidere aplicatie e Prin butonul =¥ situat in coltul din dreapta sus (Alt+F4).

1. Deschide aplicatia de calcul tabelar Microsoft Excel.

2. Salveaza registrul cu numele § si cu extensia .x/sx.

3. Redenumeste prima foaie de calcul elevi.

Adauga doua foi de calcul. Redenumeste-o pe a doua colegi.

Evidentiaza cu o culoare, la alegere, a doua foaie de calcul.

S oA

Ascunde Foaie3 din registru.
Insereaza o noua foaie de calcul. Mut-o pe prima pozitie. Redenumeste-o medii.

Salveaza registrul cu numele opt, cu extensia .pdf.

© SN

Adauga in bara de acces rapid butonul Sortare crescdtoare (Sort Ascending).

10. Ascunde (minimizeaza) panglica. Retine combinatia de taste!

11. Readu panglica in fereastra.

12, Modifica Zoom la 115%.

13. Modifica parametrii de salvare astfel incat sa se faca automat la fiecare /0 minute.
14. Reafiseaza foile ascunse din registru.

15. Salveaza si inchide atat registrul, cat si aplicatia.



Rezolva urmitoarele sarcini:
Exemplu:

Cum se creeazi un nou registru atunci cand este deschisa aplicatia Excel?
Rdspuns: Se apasi Ctrl+N sau Fisier - Nou.

1. Cum salvezi cu un nou nume un registru in Excel? 1p.
2. Cum redenumesti o foaie de calcul? 1p.
3. Bifeazd raspunsul corect. 1p.
Poti evidentia printr-o culoare numele unei foi de calcul?
(] Da
(| Nu

4. O modalitate prin care poti adauga o noua foaie de calcul intr-un registru este urmatoarea: 1p.

suslizare aldturate | lp'

6.  Bifeaza raspunsul corect. 1p.
Ascunderea unei foi de calcul are ca efect stergerea ¢i definitiva din registrul din care facea
parte.

O Da
O Nu
7. Asociaza figurile din coloana A cu cele din coloana B: Ip.

coloana A coloana B

a) S
S -

A [ C

d) e

1
2)
3)
4)

3 B
e) S e————

8.  Incercuieste litera corespunzatoare raspunsului corect. 1p.

Butonul marcat in figura $t S’ 0C ) are rolul:

1

e

b) Particularzare bard de instrumente Acce

c) Ih"nmn‘\l'-'..e‘i'

9. Incercuieste litera corespunzditoare raspunsului corect. 1p.
B8, ca identificator de celuld, semnifica:
a) B: eticheta de coloand, 8: eticheta de rand,;
b) B: eticheta de rand, 8 eticheta de coloana;
c) B: numele registrului, 8: eticheta foii de calcul.

Din oficiu: 1p.




In continuare, vei afla cum poti edita elementele foii de calcul: celuld, coloani, rand.

Selectare

Selectarea unei celule se poate face in mai multe moduri. Cel mai simplu, este sa executi c/ick in celula
dorita. O alta modalitate, pe care o poti folosi mai ales dacé celula dorita nu este vizibild in zona de lucru, este
sa tastezi coordonatele celulei in caseta de nume (de exemplu, daca scrii S43 in caseta de nume si apesi

Enter, se activeaza celula S43).

Cum faci daca doresti sa selectezi mai multe celule? Foarte 55 oS
simplu. Daca celulele sunt adiacente, cu ajutorul mouse-ului, : |
apasand butonul stang si tindnd apasat, deplasezi cursorul mouse- Al | :
ului peste toate celulele din grupul dorit. Toate celulele selectate l o e el
vor avea un chenar verde.

La fel de usor, tastezi in caseta de nume domeniul de celule
pe care doresti sa le selectezi, sub forma coltul stanga sus : coltul
dreapta jos si apoi apesi Enter. In figuri, s-a selectat domeniul —
de celule B2 : D5. Dupi apasarea butonului Enter, in caseta de 2| '
nume riméne scris doar coltul din stdnga sus, de exemplu B2. | A28 R |

Daca celulele nu sunt adiacente, apesi tasta Ctrl, iar cu & B

ajutorul mouse-ului, selectezi fiecare celula dorita. Toate celulele i
selectate vor avea un fundal gri. ; |
I

Renuntarea la selectie se face executand click oriunde in 4
zona de lucru. S

Selectarea unui rand intreg se realizeaza prin pozitionarea ,
cursorului mouse-ului la capatul randului ce se doreste a fi - [
selectat (pe eticheta de rand) si executarea unui c/ick. :

Daci doresti selectarea mai multor randuri adiacente, selectezi eticheta primului rind dorit, tii apdsata
tasta Shift si selectezi eticheta ultimului rAnd dorit in selectie. Sau, tinand apasat cursorul mouse-ului, il
tragi peste etichetele tuturor randurilor dorite. l

Selectarca unei coloane intregi se realizeazda prin . I
pozitionarea cursorului mouse-ului deasupra coloanei ce se .
doreste a fi selectata (pe eticheta de coloand) si executarea unui
click.

srren

Daci doresti selectarea mai multor coloane adiacente, selectezi eticheta primei coloane dorite, tii apasata
tasta Shift si selectezi eticheta ultimei coloane dorite in selectie. Sau, tinand apasat cursorul mouse-ului, il
tragi peste etichetele tuturor coloanelor dorite.

Daca doresti selectarea mai multor randuri neadiacente, selectezi eticheta primului rand dorit, tii apdsata
tasta Ctrl si selectezi eticheta randurilor dorite in selectie. Se procedeaza asemandtor pentru selectarea mai
multor coloane neadiacente.

-




Pentru selectareassimultand a unui rand si a unei coloane,
se-fine apasatd tasta Ctxl si se selecteaza cu mouse-ul randul si
coloana dorita.

contine un triunghi (cursorul isi schimba forma, 1) sau apesi

Pentru selectarea intregii foi de calcul, executi click pe g
casuta din coltul din stanga sus al foii de calcul, casuta care /‘1} T
tastele Ctr1+A (selectare totald). :

R e i

Exemple:

++ pentru selectarea coloanei B din foaia de calcul, se tasteazi in caseta de nume B:B;

+ pentru selectarea tuturor coloanelor adiacente de la B la D din foaia de calcul, se tasteazi in
caseta de nume B:D;

«* pentru selectarea tuturor coloanelor adiacente de la B la D si a coloanelor adiacente de la H la K
din foaia de calcul, se tasteazi, in caseta de nume, B:D, H:K;

++ pentru selectarea liniei 3 din foaia de calcul, se tasteaza, in caseta de nume, 3:3;

< pentru selectarea tuturor liniilor adiacente de la 3 la 5 si a liniilor adiacente de 1a 8 la 12 din
foaia de calcul, se tasteazi, in caseta de nume, 3:5,8:12.

Copiere, mutare, stergere

inainte de a copia, muta, sterge randuri sau coloane, este necesard selectarea lor, procedeu invatat
anterior. Asa cum stim din clasele anterioare, se foloseste combinatia de taste Ctrl+C pentru copiere,
Ctrl+X pentru mutare, Ctr1+V pentru lipire.

Operatiile acestea pot fi realizate si executdnd click
dreapta pe eticheta randului/coloanei selectate si alegerea L]
optiunii dorite, apoi lipire in pozitia noud. De asemenea, se pot Lipire
folosi si butoanele bine cunoscute din fila Pornire (Home), )
grupul de butoane Clipboard.

Clipboard =
R EATM

in ceea ce priveste lipirea (inserarea) continutului care se-doreste a fi adus din Clipboard in foaia de
calcul, existd mai multe opfiuni:
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Valori si formatare sursi




